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Chapter 1. Scenario: Connecting IBM MessageSight,
WebSphere MQ, and WebSphere Application Server getting
started

By connecting to IBM MessageSight, an existing solution involving WebSphere MQ
and a Java EE application on WebSphere Application Server can be extended to
process a high volume of messages. This scenario leads you through the key tasks
required to connect an existing WebSphere MQ and WebSphere Application Server
installation to IBM MessageSight and check it works with a sample application.

This scenario was developed using a sample WebSphere MQ installation, and uses
sample applications to demonstrate the use of WebSphere Application Server
connected to WebSphere MQ and MessageSight. If you want to try the scenario,
you can set up a copy of the sample installation as described in the scenario. You
can use the sample applications provided with the scenario to verify your progress
through each stage.

Notes

This scenario applies to WebSphere® Application Server Version 8 with IBM®

MessageSight version 1.0.1.
This scenario was developed and tested with WebSphere Application
Server Version 8 and IBM MessageSight version 1.0.1. If you use
WebSphere Application Server Version 7, you will notice some differences
like using the IBM Installation Manager instead of the installation wizard
described in this scenario.

Optional information to help you learn while implementing the solution
The scenario contains blocks of optional information marked by Why? or
What else?. You do not need to read this information to complete the
scenario, but might choose to learn more:

Why? Describes why you are instructed to do something. For example:

Why am I doing this?
You use the Scope property to set the level at which the
activation specification is visible. The cell scope is the highest
level, giving the activation specification the greatest visibility.

What else?
Describes what else you might do, or want to learn about, related to
what you are reading in the main window. For example:

What else might I do or be interested in?
You can also create activation specifications at other levels.
For example, if you have multiple servers you might create
an activation specification for each server, using the server
scope, so that you can specify different settings to be used for
each server.

© Copyright IBM Corp. 2011 1



Tip: Some “Why?” and “What else?” information provides links that
would take you to information resources outside the scenario. To complete
a scenario, you do not need to follow such links; they are provided only as
optional aids for your learning.

Related information:

Scenarios and Patterns
This scenario in the Scenarios and Patterns information center

Product web page
IBM MessageSight product web page

Product web page
WebSphere Application Server product web page

Library page
WebSphere Application Server library page

Product web page
WebSphere MQ product web page

Library page
WebSphere MQ library page

What's new?
This scenario has been updated to add an electronic book (ebook) version of the
scenario in EPUB format.

The EPUB file is linked in the “Related resource” list on the scenario welcome
page.

You can read EPUB files with many eBook readers; for example, the iBooks app for
Apple products, a variety of ebook reader apps for Android devices, and dedicated
eBook reader devices like the Barnes & Noble Nook eReader range and the Sony
Reader. You can also read ePub files in your web browser with EPUBReader
add-on for Firefox and MagicScroll for Chrome. If you want to read an EPUB file
on the Amazon Kindle, you can convert EPUB files to kindle format with a
converter like Calibre.
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Chapter 2. Planning the solution

You can connect IBM MessageSight to WebSphere MQ and WebSphere Application
Server in a number of different ways. Review the topics in this section to
understand what is covered in this scenario, the reasons why a business might
want to follow the scenario, the user roles involved, and an overview of the
solution proposed by the scenario.

Assumptions
This scenario makes several assumptions about your system, such as the version of
the products that you are using.

This scenario assumes the following points:
v You are using the Windows operating system.
v This scenario was developed by using WebSphere Application Server V8.5.

Instructions are provided for obtaining and installing fix packs for WebSphere
Application Server.

Note: This scenario applies to the use of WebSphere Application Server Version
8 with IBM MessageSight version 1.1.

v You do not consider full hardening of security for MessageSight. This scenario
does not describe security configuration. However, if you do have security
configured for MessageSight, you should still be able to complete the scenario.

What else might I do or be interested in?
IBM MessageSight is scalable to deliver large amounts of data to analytics
engines and other types of big data application. The HA nature of IBM
MessageSight is its ability to withstand software or hardware outages so that
it is available as much of the time as possible. See IBM MessageSight
Information Center for more information.

Business overview
A company has an existing messaging infrastructure using WebSphere Application
Server and WebSphere MQ and now wants to add IBM MessageSight to deal with
a large amount of data from outside of the existing system.

A company has an existing messaging infrastructure provided by WebSphere MQ
for some existing applications. The company wants to extend this to include
communication with devices over the internet using machine to machine (M2M)
messaging. The sample in this scenario is a car manufacturer who wants to analyze
data from a large number of cars in real time.

In general, the following must be taken into account:
v Volume and cost of data that is transmitted, especially in machine to machine

(M2M) messaging with limited data plans
v Power consumption of battery-powered devices
v Responsiveness (near-real time delivery of information)
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v Reliable delivery over fragile connections
v Security and privacy
v Scalability

Limited data plans and power consumption are not as important for the car
manufacturer since the devices will be attached to specific cars, but might be
important considerations for other similar scenarios. The MQ Telemetry Transport
(MQTT) protocol is designed to meet these challenges.

Additionally, the company is concerned about the security of implementing this
with their existing WebSphere MQ messaging infrastructure. IBM MessageSight is
more suitable for this situation since it is not affected by Operating System
vulnerabilities and is capable of handling a much higher load. This means the
system is more secure and can handle the number of messages being sent by all of
its cars.

User roles and interactions
Roles used throughout these scenarios, with interactions between roles for scenario
tasks.

Although roles to develop the solution are listed, this scenario focuses on
deploying a solution that connects IBM MessageSight to WebSphere MQ and
WebSphere Application Server.

Develop the solution

Develop the software aspects of the solution.

Software Architect
The Software Architect is responsible for dividing the required function
between the components that make up a software solution. This person
works with the specifications and standards used by existing IT systems,
and determines where enhancements or new components must be written
by the Developer.

Developer
The Developer is responsible for creating and testing the software
components and linking them together. In some cases the Developer might
need information from the Administrator, for example if the Developer
must use an existing queue name in their software code. After the
Developer finishes creating the software components, the Developer gives
those components to the Administrator for deployment.

Deploy the solution

Deploy the solution for production use, by installing, configuring, and testing the
components that provide the solution.

Administrator
The Administrator installs and configures the components that support the
solution, in this case MessageSight, WebSphere MQ, and WebSphere
Application Server. The business might have a different Administrator for
each product, or one Administrator might perform installation and
configuration for all components. If the Administrators are different they
might need to exchange information. For example, in this scenario the
MessageSight administrator and WebSphere MQ administrator must share
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information for the MQ Connectivity feature in MessageSight. The
Administrator also deploys the software components given to them by the
Developer.

Test Implementer
The Test Implementer runs the tests to validate the solution and that the
solution is ready for production use. For example, can the solution be
started, stopped, backed up, and recovered after a system failure as well as
be maintained?

Technical solution
This scenario describes one way of connecting IBM MessageSight to WebSphere
MQ and WebSphere Application Server.

Overview: Initial IT configuration
Company A has an existing IT configuration that uses WebSphere MQ for its
messaging infrastructure. This scenario describes adding IBM MessageSight to that
initial messaging infrastructure.

The initial IT configuration includes several components that an administrator
configures or uses, as shown in Figure 2 on page 9:

JMS application
A stand-alone application that business users interact with, for example to
register an order. The application uses the Java™ Message Service (JMS) for
asynchronous messaging.

Note: The JMS application will not be provided for verification.

Figure 1. User role interactions to deploy the solution
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Why am I doing this?

v JMS is the Java EE messaging standard that is widely supported.
JMS-based applications are therefore portable across many
messaging products.

v JMS provides a level of abstraction from the details of the
messaging layer, simplifying the application development process.

v JMS provides asynchronous communication, enabling applications
to run without having to wait for a reply, unlike tightly coupled
systems such as remote procedure call (RPC).

v Applications that use JMS do not directly specify details to access
resources. Instead, they look up and use administered JMS objects
such as a connection factory and a destination.

What else might I do or be interested in?
For some situations, other messaging standards might be more
suitable than JMS. For example IBM Message Service Clients for C,
C++ and .NET, also known as XMS, are APIs that provide similar
benefits to JMS for non-Java applications. XMS is therefore more
suitable if you are using the .NET platform, or you want to integrate
existing C++ applications with newer Java EE applications.

The application uses point-to-point messaging to send messages to a queue
in the infrastructure and processes reply messages, to provide the business
user with an appropriate response.

Why am I doing this?
In this messaging model, an application sends a message to a queue,
and another application receives the message from the queue and
acknowledges receipt of the message. This model is the simplest form
of messaging because it involves only two endpoints. This model is
also the most appropriate for the scenario sample application: a single
client requests information from a single server.

What else might I do or be interested in?
In the alternative messaging model, publish/subscribe, a publisher
publishes a message to a message topic. Subscribers subscribe to the
topic to receive messages. The publisher and subscriber do not have
any information about each other, and the message is received by
zero or more recipients.

Q1 [Message queue]
The WebSphere MQ queue that the JMS application sends messages to.

Queue manager, sampleQM
The WebSphere MQ queue manager that provides the initial messaging
infrastructure. It hosts the queue that the JMS application works with.
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Java EE application
The application consumes and works with messages on the MessageSight
queue, Q1. This application runs on an application server of the WebSphere
Application Server product that has been installed and connected with
MessageSight.

The sample application in this scenario provides a message-driven bean
(MDB) as an asynchronous message consumer. When a message arrives at
the queue, the MDB automatically processes the message without the
application having to explicitly poll the queue.

Why am I doing this?
MDBs are activated by the EJB container in WebSphere Application
Server on receipt of a message. A typical MDB performs messaging
functions, and calls one or more session beans to perform business
logic. Because of this separation of function, you can easily change
and reuse units of business logic without affecting the messaging
function of the application.

Application server
A server program in WebSphere Application Server that provides the
execution environment for Java EE application programs.

WebSphere Application Server JNDI namespace
WebSphere Application Server includes a name server which provides
access to the following JMS administered objects through the Java Naming
and Directory Interface (JNDI).

Activation specification
A JMS activation specification can be associated with one or more
MDBs and provides the configuration necessary for them to listen
for messages arriving at a destination. Activation specifications
process inbound messages to the MDB.

Why am I doing this?
Activation specifications are part of the Java EE Connector
architecture (JCA) 1.5 standard. JCA 1.5 provides a standard
way to integrate JMS providers, such as WebSphere MQ, with
Java EE application servers such as WebSphere Application
Server.

What else might I do or be interested in?
Use of listener ports is an older configuration method for
MDBs to listen for messages arriving at a destination. The use
of listener ports is stabilized in WebSphere Application Server
Version 7 and later. If you are using WebSphere Application
Server for the first time avoid using listener ports.

Connection factory, myCF
A JMS connection factory object defines a set of standard
configuration properties for connections. An application uses a
connection factory to create a connection to WebSphere MQ.

Chapter 2. Planning the solution 7



Destination, myQueue
A JMS destination can be a topic or a queue. In this scenario, the
destination is a queue, and identifies the WebSphere MQ queue
that applications send messages to, or from which an application
receives messages, or both. An application looks up the destination
in the JNDI namespace to create a connection to the WebSphere
MQ queue.

In this scenario, when creating JMS objects in WebSphere Application
Server, you specify full details rather than use a client channel definition table
(CCDT) that has been exported from WebSphere MQ.

Why am I doing this?
A CCDT makes configuring objects in WebSphere Application Server
easier, because it contains information that is required to connect to
WebSphere MQ. If you do not specify a CCDT you must enter this
information yourself. This scenario does not use a CCDT, so that you
can see more clearly what information is required to make a
connection.

What else might I do or be interested in?
A CCDT is particularly useful if your client applications might need
to connect to a number of alternative queue managers. This scenario
does not cover that situation.

Tip: This scenario was developed by using a sample version of the initial IT
configuration described. If you want to try out the scenario, you can either follow
the instructions to configure WebSphere Application Server to communicate with
your own MessageSight system, or set up a copy of the sample IT configuration.
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Extending the Initial IT configuration with IBM MessageSight
The company adds a Java EE application on WebSphere Application Server to
consume and work with messages from an existing messaging infrastructure
provided by WebSphere MQ.

The delivered IT configuration includes all the components in “Overview: Initial IT
configuration” on page 5 and IBM MessageSight as a messaging provider for
WebSphere Application Server. See Figure 3 on page 11.

IBM MessageSight as a messaging provider for WebSphere Application Server
The MessageSight messaging provider in WebSphere Application Server
makes JMS messaging available to WebSphere Application Server
applications by using the existing capabilities in the MessageSight
environment.

Figure 2. Delivered logical topology. The high-level logical topology diagram for the initial WebSphere MQ messaging
infrastructure.
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Why am I doing this?
WebSphere Application Server applications can interact with
MessageSight destinations to send and receive messages in the same
way as any JMS application in the MessageSight environment.

Java EE application
The application consumes and works with messages from MessageSight.
This application runs on an application server of the WebSphere Application
Server product that has been installed and connected with MessageSight.

The sample application in this scenario provides a message-driven bean
(MDB) as an asynchronous message consumer. When a message arrives at
the queue, the MDB automatically processes the message without the
application having to explicitly poll the queue.

Why am I doing this?
MDBs are activated by the EJB container in WebSphere Application
Server on receipt of a message. A typical MDB performs messaging
functions, and calls one or more session beans to perform business
logic. Because of this separation of function, you can easily change
and reuse units of business logic without affecting the messaging
function of the application.

You can download the sample applications:
v SampleCarApp.ear
v AutoRemote.war
v SampleCarApp.ear
v AutoRemote.war
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Production physical topology and product mapping
The production physical topology specifies the recommended operational
environment (machines, operating systems, and software products) for running the
applications and services of the solution.

Figure 3. Delivered logical topology. The high-level logical topology diagram for new software functions delivered by
integrating IBM MessageSight into the initial WebSphere MQ messaging infrastructure. This delivered logical topology
shows the new functions as new or extended logical components, integrated with the software functions and products
from the initial logical topology.
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Node Operating system and hardware Software

Host 1 (runtime node) v Windows Server 2003 or 2008,
Standard or Enterprise Edition.
You can use Windows 7, or for
32-bit environments, Windows
Vista or Windows XP Professional,
but these operating systems are not
supported for production use of
WebSphere Application Server.

v Intel EM64T, AMD Opteron, or for
32-bit environments, Intel Pentium
processor at 2.33 GHz or faster

v 1 GB physical memory

v 3 GB free disk space

v WebSphere Application Server

v IBM MessgaeSight

Prerequisite software:

v A web browser for use by the
Launchpad, Windows Explorer,
and WebSphere Application Server
administrative console: Microsoft
Internet Explorer Version 6.0, or
Mozilla-based browsers Version 1.7
or higher

Figure 4. Production physical topology
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Chapter 3. Implementing the solution

Implementing the solution in this scenario involves connecting IBM MessageSight
to WebSphere Application Server and WebSphere MQ, which provided the initial
messaging infrastructure for a company.

Before you begin

The starting point for this scenario is an existing, verified, WebSphere Application
Server and WebSphere MQ installation as the initial messaging infrastructure.

This scenario was developed using a sample installation, and uses sample
applications to demonstrate connecting to MessageSight. If you want to try the
scenario, you can set up a copy of the sample installation as described in the
scenario. You can use the sample applications provided with the scenario to verify
your progress through each stage.
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About this task

After connecting MessageSight to WebSphere MQ and WebSphere Application
Server, you can use the connection by deploying a Java EE application to run on
WebSphere Application Server. This scenario describes use of a sample Java EE
application that is deployed onto WebSphere Application Server and used to verify
the solution.

Creating a sample initial IT configuration
This scenario was developed by using a sample initial IT configuration. Follow the
instructions to set up the sample initial IT configuration to try out the scenario in
the same way as it was originally developed.

Installing WebSphere MQ
To complete this scenario you must have a functioning WebSphere MQ messaging
network. This task provides basic instructions to install WebSphere MQ if you do
not already have it installed on your system.

Figure 5. Delivered logical topology, including MessageSight. The high-level logical topology diagram for new software
functions delivered by integrating MessageSight into the initial messaging infrastructure. This delivered logical topology
shows the new functions as new or extended logical components, integrated with the software functions and products
from the initial logical topology.
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Before you begin
v You must have local administrator authority when you are installing. Define this

authority through the Windows facilities.
v Ensure that the machine name does not contain any spaces.
v Ensure that you have sufficient disk space, up to 600 MB, to fully install

WebSphere MQ for Windows.
v Determine whether any WebSphere MQ users are defined on Windows 2000 or

later domain controllers.

Why am I doing this?
WebSphere MQ checks that only authorized users can access queue
managers or queues. When a user attempts such access, WebSphere MQ
uses its own local account to query information about the user. However,
domain controllers running on Windows 2000 or later can be configured
such that WebSphere MQ cannot use local accounts to make these queries.
In this situation, you must provide WebSphere MQ with a special account
to use. This account is necessary when both of the following conditions
apply:
– Any domain controller on your network is running on Windows 2000 or

later
– Local user accounts are not authorized to query the group membership

of the domain user accounts

If you require a special account, refer your domain administrator to the
instructions in Creating and setting up domain accounts for WebSphere
MQ in the WebSphere MQ information center.

If you want to investigate the requirements for installing WebSphere MQ in more
detail, see System Requirements for IBM MQ.

About this task

This task describes the basic steps to install WebSphere MQ on the Windows
operating system.

The installation programs contain links to further information if you require it
during the installation process. The installation process has four parts:
1. Use the Launchpad to check and install software requirements, specify network

information, and start the WebSphere MQ installation wizard.
2. Use the WebSphere MQ installation wizard to install the software, and start the

Prepare WebSphere MQ wizard.
3. Use the Prepare MQ wizard to start the WebSphere MQ service and start the

Default Configuration wizard.
4. Optionally, use the Default Configuration wizard to create objects for verifying

the installation using the Postcard application supplied with WebSphere MQ.

Procedure
1. Insert the WebSphere MQ for Windows Server DVD into the DVD drive. If

autorun is enabled, the installation process starts. Otherwise, double-click the
Setup icon in the root folder of the DVD to start the installation process.

2. Use the buttons on the left of the Launchpad to review and, if necessary,
modify the software requirements and network configuration.
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WebSphere Eclipse Platform 3.3 is required for using the WebSphere MQ
Explorer and Managed File Transfer Application components. You can use the
launchpad to install this software if required: after you choose whether to
install from a DVD or your file system, the Launchpad opens a dialog box
with the Eclipse Setup.exe program selected. Click Open to run the
WebSphere Studio IES 3.3 installation wizard. After installing, click Refresh in
the Launchpad to update the status of the software requirements.

3. On the WebSphere MQ Installation page of the Launchpad, Select installation
language and click Launch IBM WebSphere MQ Installer to start the IBM
WebSphere MQ - InstallShield Wizard.

4. On the setup wizard, select the Custom setup type and click Next.
5. On the Installation Details page, specify the Installation Name and the

Installation Description field and click Next.
6. Optional: You can click the Change button to change the Installation folder for

program files. Click Next.
7. Select folder for log files and click Next.
8. On the Features page, click the icon and select Install this feature for the

following features:
v Server
v Telemetry Service
v MQ Explorer
v Telemetry Clients
v Development Toolkit
v Java and .NET Messaging and Web Services

Click Next to go to the Ready to Install WebSphere MQ page.
9. On the Ready to Install WebSphere MQ page, click Install and go to the

Installing WebSphere MQ page. It takes several minutes to install the
WebSphere MQ. At the end of the process, the WebSphere MQ Setup window
displays the message Installation Wizard Completed Successfully. Click
Finish. The Prepare WebSphere MQ wizard starts automatically.

10. Follow the instructions in the Prepare WebSphere MQ wizard.

Why am I doing this?
The Prepare WebSphere MQ wizard helps you to configure WebSphere
MQ files and a user account for your network. You must run the wizard
to configure the WebSphere MQ Service before you can start any queue
managers.

a. On the Welcome to the Prepare WebSphere MQ wizard page of the wizard,
click Next. The wizard performs some configuration and displays status
messages, then displays the WebSphere MQ Network Configuration page.
The contents of this page vary according to your use of domain
controllers.

b. Follow the instructions forWebSphere MQ Network Configuration page
and then click Next to continue through the wizard until the wizard
displays the Completing the Prepare WebSphere MQ Wizard page.

11. Optional: If you want to use the WebSphere MQ Postcard application to verify
your installation, click the Set up the Default Configuration link to display
the WebSphere MQ Default Configuration window.
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Why am I doing this?
The default configuration creates objects, such as a queue manager called
QM_machine_name, that you can use to verify the success of your
installation by using the Postcard application that is supplied as part of
WebSphere MQ. If you do not create the default configuration, you can
still use the Postcard application later on, after you have created your
own objects in WebSphere MQ.

Note: You cannot create the default configuration if you have already created
other queue managers; you must first delete the other queue managers then
run the Default Configuration wizard.
a. The WebSphere MQ Default Configuration window shows an initial

summary of the configuration you are about to create. This window
remains on screen while you proceed through the pages of the Default
Configuration wizard. Click the Set up Default Configuration... button to
start the Default Configuration wizard.

b. Click Next to move through the information pages.
c. On the Select Options page, clear both the Allow remote administration of

the queue manager and Join the queue manager to the default cluster
check boxes, then click Next.

Why am I doing this?
This scenario assumes that you have one machine on which you are
installing WebSphere Application Server and WebSphere MQ. You
therefore do not need to administer the queue from another machine.
Clustering is not described in this scenario.

d. On the summary page, click Finish. A dialog box is displayed while the
default configuration is created.

What else might I do or be interested in?
You can use this window after installation to change the default
configuration. To display this window after installation, use the
Windows Start menu to start the Prepare WebSphere MQ wizard,
then follow the steps.

The existing WebSphere MQ Default Configuration window is updated
with the results of the configuration.

e. Click Close to close the Default Configuration wizard.
12. Leave the Launch WebSphere MQ Explorer check box selected, choose

whether to start Notepad to view the release notes, then click Finish. The
WebSphere MQ Explorer starts.

13. If you created a default configuration, verify your installation by using the
Postcard application that is supplied with WebSphere MQ.
a. If the Welcome page is not already displayed, click Help > Welcome to

display it.
b. Click the Get Started icon.
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c. Click the Launch the Postcard Application icon to display the Postcard -
Sign On dialog box.

d. Click Help in this and other Postcard application dialog boxes to view
instructions about running the Postcard application.

If you did not create a default configuration, you can still follow these steps to
verify your installation, but you must first configure a queue manager as
described in the next task of this scenario.

Note: Running the Postcard application on a non-default configuration
automatically creates a queue called postcard on your queue manager. You
can delete this queue after using the postcard application.

Results

You have installed WebSphere MQ and are ready to configure objects such as
queues and queue managers.

If there were problems during installation, use the .log files in the C:\Documents
and Settings\userID\Local Settings\Temp directory, and the amqmsccw.txt and
amqmjpse.txt files in the installation directory, to investigate. The default
installation directory is C:\Program Files\IBM\WebSphere.

What to do next

Follow the instructions in Configuring the JNDI namespace and administered
objects to configure WebSphere MQ for use by the sample application.

Configuring the MQTT service with WebSphere MQ
The MQTT service for WebSphere MQ can be installed and ready to use with the
following steps.

Before you begin
v Set up and configure the sample IT configuration from Creating a sample initial

IT configuration on your system.
v You must have local administrator authority when you are installing. Define this

authority through the Windows facilities.

About this task

This task modifies an existing WebSphere MQ installation and creates an MQTT
service to listen on port 1883. The configuration gives everyone permission to
publish and subscribe to any topic.

Procedure
1. Optional: If you do not install Telemetry Service and Telemetry Clients when

you install WebSphere MQ in Installing WebSphere MQ, you can modify the
existing installation to include the MQTT service.
a. Run the same WebSphere MQ installer as in the initial sample IT

configuration. This is the IBM WebSphere MQ InstallShield Wizard. For
more information, see steps 1-3 in Installing WebSphere MQ.

b. In the installer, select Maintain or upgrade an existing instance.
c. Select your existing installation and click Next.
d. Leave Modify selected and click Next.
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e. Click the icons for Telemetry Service and Telemetry Clients, and select
Install this feature to install each feature.

f. Click Next and then click Modify. The installer will stop any WebSphere
MQ activity if it is running.

2. Open WebSphere MQ Explorer.
3. Run the Telemetry “Define sample configuration” wizard.

a. Optional: If the “MQ Explorer - Content” window is closed, click Window
> Reset Perspective.

b. Expand sampleQM and select the Telemetry folder.
c. Click Define sample configuration to start the wizard.
d. Click Finish to create the telemetry service and run the MQTT Client Utility.

4. Test the connection in the MQTT Client Utility window.
a. In the Connection section, click Connect .
b. In the Subscription section, click Subscribe.
c. In the Publication section, click Publish. In the Client History section, you

can see that a message has been published and received.

Results

You have installed the MQTT service.

Installing WebSphere Application Server Version 8 or later
Install WebSphere Application Server 8 or later by using Installation Manager. At
the end of this task, you are ready to configure WebSphere Application Server to
communicate with MessageSight.

Before you begin
v You must have local administrator authority when you are installing. Define this

authority through the Windows operating system facilities. The administrator ID
must not contain spaces.

v Ensure that you have sufficient disk space. You require up to 2 GB for all
components.

v Ensure that prerequisites and corequisites are at the required release levels. On
the WebSphere Application Server detailed system requirements page, click the
link for your operating system and the link for software to see information
about supported operating systems and browsers, and hardware requirements.

About this task

This task describes the basic steps to install WebSphere Application Server 8.5 on
the Windows 7 (SP1) operating system by using Installation Manager.

Procedure
1. If you haven't installed IBM Installation Manager before, install it.

a. Extract the Installation Manager archive file.
b. Switch to Installation Manager archive directory and double-click the

install.exe file.
c. In the Install Packages window, select the version number, for example

Version 1.5.2 , and then click Next.
d. Click I accept the terms in the license agreement, and then click Next.
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e. In Installation Manager Directory field, type the file path. The file path is
the location where you want to install IBM Installation Manager.

f. Click Next, and then click Install. A progress bar is displayed, which
shows that the installation is in progress.

When the installation is complete, a window is displayed, indicating that IBM
Installation Manager is installed.

2. Click Restart Installation Manager in the lower right of the window.
Alternatively, you can click Start > All Programs > IBM Installation Manager
> IBM Installation Manager to start Installation Manager.

3. Click Install.
4. If a message is displayed that states Installation Manager cannot find any

packages to install, add WebSphere Application Server to the repository.
a. Click the Repositories link in the Repository connections field.
b. Click Add Repository in the upper right of the Preference window.
c. Click Browse and find the repository.config file for WebSphere

Application Server.
d. Click OK.
e. Click Test Connections on the right of the Preference window. If a

message is displayed that states All the selected repositories are
connected, WebSphere Application Server is added to the repository.

f. Click OK to close the window and click OK again to confirm adding the
repository.

5. Select the version number of WebSphere Application Server, for example
Version 8.5.0.0, and then click Next.

6. Click I accept the terms in the license agreement, and then click Next.

7. Click Next, then click Next again.
8. Select the languages that you want and click Next.
9. Select the components that you want and click Next.

10. Click Install. A progress bar is displayed, which shows that the installation is
in progress.

11. When the installation is complete, a window is displayed, which indicates that
the packages are installed. Select the programs that you want to start and click
Finish. WebSphere Application Server is successfully installed.

12. Create an application server profile
a. Start Profile Management Tool. For example, click Start > All Programs >

IBM WebSphere > IBM WebSphere Application Server V8.5 > Tools >
Profile Management Tool.

b. Click Create.
c. In Environment Selection window, expand WebSphere Application Server,

and click Application server, and then click Next.
d. In Profile Creation Options window, leave the option as Typical profile

creation, and then click Next.
e. Choose whether to enable administrative security and click Next. If you

choose to enable it, every time you use WebSphere Application Server, you
must prove your identity.

f. Confirm your settings and click Create.
g. When the profile creation is complete, the Profile Creation Complete

window is displayed. Clear Launch the First steps console and click
Finish. An application server profile is successfully created.
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Results

WebSphere Application Server is installed. If you encountered a problem when
installing, see the IBM Installation Manager Information Center. For further
information about where to find this information center, see About IBM Installation
Manager Information Center.

What to do next

Follow the instructions in “Configuring WebSphere Application Server” to
configure WebSphere Application Server to communicate with MessageSight.

Configuring WebSphere Application Server
Create an activation specification, connection factory, and topic for WebSphere
Application Server applications to use.

About this task

To use JMS messaging between WebSphere Application Server and MessageSight,
you create the following objects in WebSphere Application Server.
v Activation specification
v Connection factory
v Topic (a type of JMS destination)

These objects are described in “Extending the Initial IT configuration with IBM
MessageSight” on page 9.

Procedure
1. If WebSphere Application Server is not already started, click Start > All

Programs > IBM WebSphere > IBM WebSphere Application Server V8.5 >
Profiles > AppSrv01 > Start the server for example. A command window is
displayed until the server is started; this process might take a few minutes.

2. If the administrative console is not already started, click Start > All Programs >
IBM WebSphere > IBM WebSphere Application Server V8.5 > Profiles >
AppSrv01 > Administrative console for example.

Note: You must log on even if you did not enable administrative security when
you installed the product. If you did not enable administrative security, the
user ID is used only to distinguish changes that you make in the administrative
console from changes made by other users.

3. Create a connection factory.

Why am I doing this?
A JMS connection factory contains information about how to create a
connection. When an application needs a JMS connection, the factory
creates a connection instance. The connection factory requires the same
connection information as the activation specification that you created
earlier, but is used for outbound messages from the MDB, whereas the
activation specification is used for inbound messages.
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What else might I do or be interested in?
With previous versions of the JMS specification, you had to create either a
queue connection factory or a topic connection factory, depending on your
required messaging pattern (point-to-point or publish/subscribe). With the
common interfaces of the JMS 1.1 specification, you can now create a
generic connection factory, which creates connections to both types of
messaging destination. You can therefore use both messaging models in
the same session.

a. In the administrative console, click Resources > JMS > Connection
factories and go to the Connection factories page.

b. In the Scope field, click the drop-down list and set the scope to
Cell=cell_name, then click New under the Preferences field.

c. Select WebSphere MQ messaging provider, then click OK and go to the
Create WebSphere MQ JMS resource page. The “Create WebSphere MQ JMS
resource” wizard starts.

d. On the “Step 1: Configure basic attributes” page enter a Name of your
choice, enter jms/replyCF for the JNDI name, then click Next.

Why am I doing this?
The name you choose is used to display the connection factory in the
administrative console. The JNDI name is used to reference the object
in the JNDI namespace. The JNDI name is also used in the sample
MDB application code; if you want to use a different JNDI name you
must change the MDB to match, then redeploy the application.

e. On the “Step 2: Select connection method” page, select Enter all the
required information into this wizard and click Next.

f. On the “Step 2.1: Supply queue manager details” page, type sampleQM in the
Queue manager or queue-sharing group name field then click Next.

g. On the “Step 2.2: Enter connection details” page, enter the following details
then click Next.

Transport
Select Bindings, then client from the drop-down list.

Why am I doing this?
In this mode, WebSphere Application Server first attempts to
connect in bindings mode, where the WebSphere MQ
messaging provider within WebSphere Application Server
connects directly to the WebSphere MQ queue manager. If this
connection attempt fails, the WebSphere MQ messaging
provider then attempts to connect by using client mode, which
uses a TCP/IP-based network. Bindings mode usually has
better performance, but can be used only when WebSphere
Application Server and WebSphere MQ are installed on the
same machine. The host name, port, and server connection
channel information is required for client mode. Bindings
mode requires the configuration of native library path
information, which you will add in a later step in this task.
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Keep Enter host and port information in the form of separate host name
and port values as selected and enter the following information:

Host name
The name of your machine.

Port The port number of the WebSphere MQ queue manager sampleQM.

This port number is displayed in WebSphere MQ Explorer under
Queue managers > sampleQM > Listeners, in the Port column of
the LISTENER.TCP row.

Server connection channel
The name of the WebSphere MQ channel to use for communication.

If you do not have a specific channel that you want to use, specify
the default channel that is created when you created the queue
manager, SYSTEM.DEF.SVRCONN.

h. Click Next

i. On the “Steps 3: Test connection” page, click Test connection.

Why am I doing this?
The Test connection button verifies that the connection factory contains
the necessary details to create a connection to WebSphere MQ. To use
this connection, you must create a queue, as described in the rest of the
steps.

If successful, the wizard displays the message A connection was
successfully made to WebSphere MQ. If not successful, check that the queue
manager name, port, and server channel that you specified are correct, then
match the values in WebSphere MQ. For example, the following error
indicates that the channel name was not found on the queue manager that
you specified.

A connection could not be made to WebSphere MQ for the following reason:
JMSCMQ0001: WebSphere MQ call failed with compcode ’2’ (’MQCC_FAILED’)
reason ’2540’ (’MQRC_UNKNOWN_CHANNEL_NAME’).

If the following error message is displayed,
A connection could not be made to WebSphere MQ for the following reason:
JMSCMQ0001: WebSphere MQ call failed with compcode ’2’ (’MQCC_FAILED’)
reason ’2035’ (’MQRC_NOT_AUTHORIZED’).

1) Open WebSphere MQ Explorer and expand IBM WebSphere MQ >
Queue Managers.

2) Right click sampleQM.
3) Click Properties > Communication and select Disabled in Channel

authentication records list.
4) On the WebSphere Application Server Administrative console, click

Previous and go back to the Steps 3: Test connection page.
5) Click Test connection.

j. Click Next, then on the Summary page, click Finish. The Messages window
is displayed. Click Save to save the changes directly to the master
configuration.

4. Add a Topic.
a. In the console, click Resources > JMS > Topics and go to the Topics page.
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b. In the Scope field, click the drop-down list and set the scope to
Cell=cell_name, then click New under the Preferences field.

c. Select WebSphere MQ messaging provider then click OK.
d. Under General Properties, enter the following values for the required fields.

Name A name of your choice.

This name is used to display the queue in the administrative
console.

JNDI name
jms/myTopic

The JNDI name is used to reference this queue in the WebSphere
Application Server JNDI namespace. The value matches the
destination name that you specified when creating the activation
specification.

Topic name
#

This value is the administrative name of the topic that you want to
communicate with. This is different from the JNDI name of the
topic.

e. Click OK.

The Messages window is displayed. Click Save to save the changes directly to
the master configuration.

5. Add an activation specification.
a. In the administrative console, click Resources > JMS > Activation

specifications and go to the Activation specifications page.
b. In the Scope field, click the drop-down list and set the scope to

Cell=cell_name, then click New under the Preferences field.

Why am I doing this?
You use the Scope property to set the level at which the activation
specification is visible. The cell scope is the highest level, giving the
activation specification the greatest visibility.

What else might I do or be interested in?
You can also create activation specifications at other levels. For
example, if you have multiple servers you might create an activation
specification for each server, using the server scope, so that you can
specify different settings to be used for each server.

c. Select WebSphere MQ messaging provider then click OK. The “Create
WebSphere MQ JMS resource” wizard starts.

d. On the “Step 1: Configure basic attributes” page, add a Name of your
choice, then type jms/SampleCarApp in the JNDI name field. Click Next.
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Why am I doing this?
The name you choose is used to display the activation specification in
the administrative console. The JNDI name is used to reference the
object in the JNDI namespace.

e. On the “Step 1.1: Specify MDB destination data” page, type jms/myTopic in
the Destination JNDI name field and ignore the Message selector filed.
Select Topic as the Destination type and then click Next.

f. On the “Step 1.2: Configure Durable Subscription” page, leave the default
option, Nondurable subscription, and click Next.

g. On the “Step 2: Select connection method” page, selectEnter all the
required information into this wizard and click Next.

h. On the “Step 2.1: Supply queue manager details” page type the name of the
WebSphere MQ queue manager, sampleQM in the Queue manager or
queue-sharing group name field, then click Next.

i. On the “Enter connection details” page, enter the following information:

Transport
Select Bindings, then client from the drop-down list.

Why am I doing this?
In this mode, WebSphere Application Server first attempts to
connect in bindings mode, where the WebSphere MQ
messaging provider within WebSphere Application Server
connects directly to the WebSphere MQ queue manager. If this
connection attempt fails, the WebSphere MQ messaging
provider then attempts to connect by using client mode, which
uses a TCP/IP-based network. Bindings mode usually has
better performance, but can be used only when WebSphere
Application Server and WebSphere MQ are installed on the
same machine. The host name, port, and server connection
channel information is required for client mode. Bindings mode
requires the configuration of native library path information,
which you will add in a later step in this task.

Keep Enter host and port information in the form of separate host name
and port values as selected and enter the following information:

Host name
The name of your machine.

Port The port number of the WebSphere MQ queue manager sampleQM.

This port number is displayed in WebSphere MQ Explorer under
Queue managers > sampleQM > Listeners, in the Port column of
the LISTENER.TCP row.

Server connection channel
The name of the WebSphere MQ channel to use for communication.

If you do not have a specific channel that you want to use, specify
the default channel that is created when you created the queue
manager, SYSTEM.DEF.SVRCONN.

j. Click Next
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k. On the “Test connection” page, click Test connection.

Why am I doing this?
The Test connection button verifies that the activation specification
contains the necessary details to create a connection to WebSphere MQ.

If successful, the wizard displays the message A connection was
successfully made to WebSphere MQ. If not successful, check that the queue
manager name, port, and server channel that you specified are correct, and
match the corresponding values in WebSphere MQ.

l. Click Next, then on the Summary page click Finish. The Messages window
is displayed. Click Save to save the changes directly to the master
configuration.

Results

You have configured WebSphere Application Server with the necessary objects to
enable communication with WebSphere MQ and MessageSight.

Installing IBM MessageSight for Developers on Oracle VirtualBox
4.3.10

IBM MessageSight for Developers is an open virtual appliance (OVA) package that
you can import into your virtualization environment. You can install IBM
MessageSight for Developers on Oracle VirtualBox 4.3.10 according to the
following procedure.

Before you begin

Minimum system requirements

The host system must have these minimum system requirements:
v A 2-core 64-bit processor with VT-x/AMD-V support
v 16 GB of available space on a hard disk
v 4 GB RAM, with a minimum of 2 GB available for the virtual appliance

By default, the OVA is configured to run with 4 GB RAM. You can change this
value to a lower setting.

Supported browsers

To use IBM MessageSight for Developers, you need access to one of the supported
browsers. For more information about the supported browsers, see “Supported
browsers” on page 27.

Procedure
1. Click Oracle VirtualBox on your computer and open it.
2. In Oracle VirtualBox, import the IBM MessageSight for Developers virtual

image OVA package.
a. Click File > Import Applicance.
b. Click the Import Virtual Application icon and navigate to the IBM

MessageSight OVA file on your computer.
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c. Click on the file name, and then click Open.
d. Click Next and then Import. The IBMMessageSightV1.1.ova file is now

importing.
3. After the IBMMessageSightV1.1.ova file is imported, click Start. The IBM

MessageSight for Developers image is now loading.
4. After the IBM MessageSight for Developers image is loaded, enter the default

user ID: admin and the default password: admin at the login prompt.
5. For Which interface would you like to configure (default is eth0), enter

eth0, and then press Enter.
6. For Use DHCP for the Ethernet port (yes/no: default no), enter Yes , and

then press Enter.
7. The URL to connect to IBM MessageSight UI is now displayed on the screen.

Open a supported browser, enter the IP address that is displayed on the
screen to connect to the IBM MessageSight Web UI.

8. Click Add Exception and then Confirm Securtiy Exception to add the IBM
MessageSight Web UI as an exception.

9. In the MessageSight Login page, enter the default user ID: admin and the
default password admin, and click Log in. The License Agreement page is
displayed.

10. Click I Agree and the License Accepted window is displayed. Click Close.
11. Follow the steps on the First Steps tab to get started with IBM MessageSight.

When you finish, click Save and Close.

Results

You have now installed IBM MessageSight for Developers on Oracle VirtualBox
4.3.10, and it is ready to be configured.

Supported browsers
You need one of the following supported web browsers. The browser must be
installed on a system that is connected to the same network as the management
port of the appliance:

Table 1. Supported web browsers by platform

Linux RHEL 6

Linux SLES 11

Windows 7

Windows 8 Mac OS X iOS 6

Firefox 10 ESR Yes Yes Yes No

Firefox 17 ESR Yes Yes Yes No

Chrome 18 Yes Yes No No

Chrome 21 Yes Yes Yes Yes

Internet Explorer 9 No Yes No No

Internet Explorer 10 No Yes No No

Safari 6 No No Yes Yes

Note: If you are using Internet Explorer, you must ensure that you are running in
Internet Explorer 9 standards mode. To change the mode, press F12.
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Configuring IBM MessageSight
To configure MessageSight, you must configure the WebSphere MQ server
connection channel, then configure MQ Connectivity in MessageSight, and then
add a Destination Mapping rule.

Procedure
1. Configure the WebSphere MQ server connection channel.

a. Create a Windows user account called MSG. The user cannot be an
administrator.

b. Use the DEFINE CHANNEL MQSC command to create a server-connection
channel that is called SYSTEM.MSG.SVRCONN for sampleQM. Click Start > Run,
type cmd to open a command prompt. On the command prompt, type the
following command:

runmqsc sampleQM
DEFINE CHANNEL(SYSTEM.MSG.SVRCONN) CHLTYPE(SVRCONN) TRPTYPE(TCP) MCAUSER(MSG)

c. Grant general WebSphere MQ access to the user account MSG:
SET AUTHREC OBJTYPE(QMGR) PRINCIPAL(’MSG’) AUTHADD(CONNECT, INQ, DSP)

d. Grant authority for the user account MSG to issue requests to WebSphere
MQ:

SET AUTHREC PROFILE(’SYSTEM.DEFAULT.MODEL.QUEUE’) OBJTYPE(QUEUE) PRINCIPAL(’MSG’) AUTHADD(DSP, GET)
SET AUTHREC PROFILE(’SYSTEM.ADMIN.COMMAND.QUEUE’) OBJTYPE(QUEUE) PRINCIPAL(’MSG’) AUTHADD(DSP, PUT)

e. Grant authority for the user account MSG to create a WebSphere MQ queue
for IBM MessageSight synchronization records:

SET AUTHREC PROFILE(’SYSTEM.IMA.*’) OBJTYPE(QUEUE) PRINCIPAL(’MSG’) AUTHADD(CRT, PUT, GET, BROWSE)
SET AUTHREC PROFILE(’SYSTEM.DEFAULT.LOCAL.QUEUE’) OBJTYPE(QUEUE) PRINCIPAL(’MSG’) AUTHADD(DSP)

f. Grant publish and subscribe authority to AutoRemote:
DEFINE TOPIC(MSGTOPIC.sampleQM) TOPICSTR(AutoRemote)
SET AUTHREC PROFILE(MSGTOPIC.sampleQM) OBJTYPE(TOPIC) PRINCIPAL(’MSG’) AUTHADD(PUB, DSP)

2. Configure MQ Connectivity in MessageSight.
a. In MessageSight, click Messaging > MQ Connectivity.

b. Under Queue Manager Connection Properties, click the 
 

icon.
c. Enter the following details:

Name myQMC

Queue Manager
sampleQM

Connection Name
The IP address and port number where your WebSphere MQ is
installed, for example, 224.0.138.177(1414). If there are more than
one connection names, use comma to separate them.

Channel Name
SYSTEM.MSG.SVRCONN

SSL CipherSpec
Ignore this field.

d. Click Test Connection.
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Why am I doing this?
The Test connection button verifies that the activation specification
contains the necessary details to create a connection to WebSphere
MQ.

v If successful, the wizard displays the message Test connection
succeeded.

v If test connection failed with error message CWLNA0309, click the message
to see the detail. If the detail is Channel error while connecting to
queue manager., run the queue manager with a different CCSID and then
restart WebSphere MQ. For example, you can open a command prompt
and type ALTER QMGR CCSID(819) in the command prompt, and then
restart WebSphere MQ and click Test Connection again.

v If test connection failed with error message CWLNA0315, click the message
to see the detail. If the detail is The operation is not authorized at the
queue manager., disable the Channel authentication records of
sampleQM in WebSphere MQ. To disable the Channel authentication
records in sampleQM,
1) Open WebSphere MQ Explorer and expand IBM WebSphere MQ >

Queue Managers.
2) Right click sampleQM.
3) Click Properties > Communication and select Disabled in Channel

authentication records list.

After the Channel authentication records is disabled, restart WebSphere
MQ and click Test Connection again.

e. Click Save.
3. Add a Destination Mapping Rule.

a. Under Destination Mapping Rules, click the 
 

icon.
b. Enter the following details:

Name Sample Rule 1

Rule Type
Select the following type from the dropdown list: MessageSight
topic subtree to MQ topic subtree

Source
AutoRemote

Destination
AutoRemote

Max Messages
Specify the maximum number of messages that can be buffered on
the destination. The default is 5000.

Retained Messages
All

c. Under the Associated queue manager connections section, select myQMC
and click Save.
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Results

You have now configured MessageSight to work with the sample application.

Deploying the sample application to WebSphere Application Server
After you deploy the sample message driven bean (MDB) application, you can use
it to verify that WebSphere Application Server is communicating with IBM
MessageSight.

Before you begin
v Download the sample applications:

– SampleCarApp.ear
– AutoRemote.war
– SampleCarApp.ear
– AutoRemote.war

Procedure
1. Start WebSphere Application Server if it is not already started and open the

administrative console.
2. Install the application.

a. Click Applications > Application Types > WebSphere enterprise
applications.

b. In the Enterprise Applications pane, click Install.
c. On the Preparing for the application installation page, select Local file

system, then browse to where you downloaded the formatter MDB
application, SampleCarApp.ear and click Next.

d. For “How do you want to install the application?”, leave the default option,
Fast path selected.

Why am I doing this?
By choosing the “fast path” option, you can skip many of the steps on
the Install New Application page; you are prompted only when
additional information is required. For more information, see the topic
Preparing for application installation binding settings in the
WebSphere Application Server information center.

Click Next.
e. Click the Step 3 link to go to the “Step 3: Bind listeners for message-driven

beans” page. Select Activation Specification and enter jms/SampleCarApp in
the Target Resource JNDI Name field.

f. On the “Step 5: Summary” page, click Finish. The program displays
messages to indicate that the application is being installed.

g. When the application is installed successfully, click the Save link that is
displayed at the end of the messages, to save your changes to the master
configuration.

h. On the Enterprise Applications page, if your new application is not running
then select it and click Start.

3. Install the web application.
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a. Click Applications > Application Types > WebSphere enterprise
applications.

b. In the Enterprise Applications pane, click Install.
c. On the Preparing for the application installation page, select Local file

system, then browse to where you downloaded the AutoRemote.war file and
click Next.

d. For “How do you want to install the application?”, leave the default option,
Fast path selected and click Next.

e. On the Step 1, Step 2, and Step 3 pages, click Next.
f. On the “Step 4: Map context roots for Web modules” page, enter

/AutoRemote in the Context Root field and click Next. Then, click Next again.
g. On the “Step 6: Summary” page, click Finish. The program displays

messages to indicate that the application is being installed.
h. When the application is installed successfully, click the Save link that is

displayed at the end of the messages, to save your changes to the master
configuration.

i. On the Enterprise Applications page, if your new application is not running
then select it and click Start.

Results

You have deployed the MDB application, which is now visible in the Enterprise
Applications pane.

Verifying the solution
Run the sample JMS and message drive bean (MDB) applications to verify that
they can communicate with each other through MessageSight and WebSphere MQ.

About this task

You have now connected MessageSight to WebSphere MQ and WebSphere
Application Server, and installed a web application and Java EE application on
WebSphere Application Server. To verify that this has been done correctly, use the
web application to send messages with some example cars.

Procedure
1. Ensure that MessageSight, WebSphere MQ, and WebSphere Application Server

are started and configured according to the sample IT configuration.
2. Open your browser. The application uses the WebSocket protocol, which is

supported by Mozilla Firefox 6.0 and later, Google Chrome 14.0 and later, and
Safari 6.0 and later.

3. Load the web application. If you are on the same machine where WebSphere
Application Server is running, then this is http://localhost:9080/AutoRemote
by default.

4. In each of the windows, enter the server address and default port (16102) of
your MessageSight server.

5. There are three Remote/Car pairs. In order for the remote to connect to a car,
the driver name should be the same for that pair. You may have a different
driver name for each Remote/Car pairing. Click Connect to connect the car
and remote pair.
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6. Change the state of the cars through the remote and observe how the store
page updates the statistics. The remotes and cars are communicating through
only MessageSight.

7. Use the remote to change the state of the cars.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing 2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N
Rochester, MN 55901
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Programming interface information
Programming interface information, if provided, is intended to help you create
application software for use with this program.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Important: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. If these and other IBM trademarked terms are marked on their first
occurrence in this information with a trademark symbol (® or ™), these symbols
indicate U.S. registered or common law trademarks owned by IBM at the time this
information was published. Such trademarks may also be registered or common
law trademarks in other countries. A current list of IBM trademarks is available on
the Web at Copyright and trademark information (www.ibm.com/legal/
copytrade.shtml).
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Sending your comments to IBM

We appreciate your input on this publication. Feel free to comment on the clarity,
accuracy, and completeness of the information or give us any other feedback that
you might have.

Use one of the following methods to send us your comments:
v Send an email to ibmkc@us.ibm.com
v Use the form on the web here: www.ibm.com/software/data/rcf/

When you send information to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate, without incurring
any obligation to you.

Include the following information:
v Your name and address
v Your email address
v Your telephone or fax number
v The publication title and order number
v The topic and page number related to your comment
v The text of your comment

IBM or any other organizations will only use the personal information that you
supply to contact you about the issues that you submit.

Thank you for your participation.
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